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With the YC61, Yamaha was starting a whole new chapter in 
2020. Soon after the market launch, the question of variants 
with a larger keyboard arose in the forums and on social 
media. True to the motto “You asked, we listened...”, Yamaha 
responded with two new models: YC88 and YC73!

This means there is now a choice of three YC instruments,  

each offering outstanding features for different requirements. 

SOUND

When it comes to versatility, YC is a virtuoso. Featuring 

premium keyboard sound with more possibilities than ever. 

Choose from authentic Yamaha grand/upright pianos, electric 

pianos and keyboard to a tonewheel organ with rotary 

speaker, synths, acoustic sounds, and more. Our proprietary 

Virtual Circuitry Modeling (VCM) recreates the circuits of 

vintage analog EQs, compressors and phasers right down 

to the transistors and resistors to capture the subtleties 

other digital simulations can’t. It’s like having an incredible 

sounding keyboard with everything, to go.

In addition to the three FM organ models, the 8-Operator FM 

engine in YC shines with various FM e-piano classics as well 

as other FM sounds from the categories lead, bass, brass, 

pads, and more. These FM Voices offer real added value 

beyond VCM and sample-based sound generation.

VCM ORGAN

The letters “YC” stand for Yamaha Combo Organ and refer 

to a tradition that began with the YC-10 in 1969. Under the 

generic term “Stage Keyboard”, it combines what a keyboard 

player needs on stage today. The YC Series offers exactly this 

combination. 

YC SERIES
REINVENTING THE STAGE KEYBOARD
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The development of electronic or electro-mechanical organs 

began about 100 years ago. Although the pipe organ initially 

served as a model, electronic organs were used relatively 

quickly and increasingly in blues, rock, jazz, and pop music, 

simply because of their portability. Even today, the typical 

sound has lost none of its charm. The sound of the historical 

instruments was subject to technical limitations such as 

limited capacity of the tone generators, “leakage” (crosstalk 

of the pickups) or “key click”. With the development of the 

fully electronic organ (transistor organ), the challenge began 

to recreate exactly these sound limitations to come as close 

as possible to the original sound. As of today, this is of 

course no longer a problem at all with sample-based sound 

generation. However, a Sample is static and produces the 

same basic sound with every keystroke. 

This is where VCM (Virtual Circuitry Modeling) comes into 

play. With VCM technology, electronic circuits can be virtually 

“recreated” and then behave as “non-static” as the original. 

This allows maximum authenticity in the organ sound. 

TOUCH

At Yamaha, we put everything we’ve learned over the last 

100 years into everything you touch. Whether you prefer the 

natural feel of a graded acoustic piano, the balanced touch of 

an electric piano or a waterfall keyboard with authentic organ 

action, there’s a YC that’s right for you. It’s no wonder more 

players reach for Yamaha keyboards than any other.

YC88 NATURAL WOOD WITH TRIPLE SENSOR ACTION

The natural wood keys and graded action of the YC88 

reproduce the weight and response of a grand piano right 

down to the feel of the heavy or light hammers in the low 

and high ends. YC88 also features a triple sensor action for 

pianists accustomed to the response and speed of grand 

pianos. You get the touch of a Yamaha acoustic piano with the 

unmatched versatility of the YC. 

YC73 BALANCED ELECTRIC PIANO ACTION

YC73 has a weighted and balanced action that models 

the unmistakable feel of an electric piano. With an E-to-E 

keyboard and a touch that falls between graded acoustic 

piano and authentic organ action, it’s quite possibly the most 

versatile YC of all. 

YC61 WATERFALL KEYBOARD

The authentic Waterfall keyboard action of the YC61 was 

created by painstaking research into traditional organ 

keyboards and constant feedback from top keyboard artists. 

The result is a keyboard that not only provides the distinctive 

touch of an organ, it gives artists new ways to express 

themselves on acoustic and electric pianos, synth leads, brass 

sections and more.
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SPOILT FOR CHOICE?

Only the YC61 is equipped with the 61-key Waterfall 

Keyboard. For “real” organists, this can be an important 

criterion, enabling the typical playing style on an organ with 

all its variations. Including, for example, the indispensable 

palm glissando, which only works so comfortably on this type 

of keyboard with its rounded front edges. This makes the 

YC61 the ideal model for purists. Its compact size also makes 

it ideal as an additional instrument in an existing keyboard 

setup. The stock of high quality sounds from the categories 

piano, e.piano, synthesizer, and more completes the concept 

of a full stage keyboard. Thus the YC61 is perfectly suited as 

a stand-alone instrument, when only a very small amount of 

equipment is required. 

Jonas Gröning

All YC models have the same level of sound  
generation: a VCM, an 8-Operator FM Sound 
Engine, an AWM2 Tone Generator, and a VCM 
Rotary Speaker simulation plus a selection of over  
35 Effects that can be used in a wide range of 
applications. Distinctive features such as the type 
of keyboard, size, and weight of the instruments 
nevertheless allow for clear positioning. 
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The YC73 is the ideal model for the keyboardist who wants to cover the widest 

possible range of sounds. And that with a still compact size, a very comfortable 

transport weight, and direct and intuitive access to all important parameters for 

sound design. Using the MIDI Master Mode the larger keyboard range already allows 

three Split Zones, using internal sounds and in combination with external sound 

generators. Another criterion that should not be underestimated is the fact that 

not every keyboardist needs a keyboard with 88 keys or is used to it from a piano. 

The “Balanced Hammer Standard” keyboard of the YC73 lies in a pleasant “middle” 

between the other two keyboard versions. 

Simon Oslender
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A musician with a strong affinity for the piano and/or even an appropriate 

education will appreciate the YC88’s “Natural Wood Graded Hammer” keyboard. 

In addition, the excellent tuning of the keyboard to the sound generation enables a  

dynamic that comes very close to playing on an acoustic piano. 

Nevertheless, the YC88 offers all the important sounds from the 

immense range of the YC Series beyond the excellent classical pianos 

and E.Pianos. For example, when playing an organ, a second keyboard 

can be integrated via MIDI - all other sounds can be controlled, too.  

Individual assignments for external keyboards can be saved for each individual  

Live Set.

Uri Gincel
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SPECIFICATIONS
Item Details

YC61 YC73 YC88
Keyboard 61 keys, semi-weighted 

waterfall keyboard (initial 

touch)

73-key BHS (Balanced 

Hammer Standard) keyboard: 

matte black keytops

88-key NW-GH3 (Natural 

Wood Graded Hammer) 

keyboard: synthetic ebony 

and ivory keytops

Tone Generation Tone Generation  

Technology

VCM Organ, AWM2, FM

Polyphony (max.) VCM Organ + AWM2: 128*, FM: 128 

*Total of VCM Organ and AWM2

Voices Number of Live Set 

Sounds

160 (Preset Live Set Sounds: 80)

Number of Voices 145 (Organ: 6 / Keys: 139)

Effects Insertion Effect:  

 Organ 1 system (pre drive) 

 Key A 2 systems (1: 32 types, 2: 32 types) 

 Key B 2 systems (1: 32 types, 2: 32 types) 

Effect: 32 types 

Speaker/Amp: 6 types (Rotary Speaker: 2 types, Amp: 4 types) 

Reverb  

Master Equalizer: 3-band (with sweepable mid)

Display Type Full Dot LCD (128 × 64 dots)

Connectors OUTPUT [L]/[R] (XLR jacks, BALANCED)

OUTPUT [L/MONO]/[R] (6.3 mm, standard phone jacks, UNBALANCED) 

[PHONES] (6.3 mm, standard stereo phone jack) 

INPUT [L/MONO]/[R] (6.3 mm, standard phone jacks) 

FOOT CONTROLLER [1]/[2] 

FOOT SWITCH [SUSTAIN]/[ASSIGNABLE] 

MIDI [IN]/[OUT] 

USB [TO HOST]/[TO DEVICE] 

[AC IN]

Size/Weight Dimensions  

(W × D × H)

896 mm × 309 mm × 108 mm 

(35-1/4” × 12-3/16” × 4-1/4”)

1086 mm × 355 mm × 145 mm 

(42-3/4” × 14” × 5-11/16”)

1298 mm × 364 mm × 142 mm 

(51-1/8” × 14-5/16” × 5-9/16”)

Weight 7.1 kg (15 lb, 10 oz) 13.4 kg (29 lb, 9 oz) 18.5 kg (40 lb, 13 oz)

Included Accessories Owner’s Manual × 1 

Power cord × 1

Owner’s Manual × 1 

Power cord × 1 

Foot pedal (FC3A) x 1

 

The contents of this table apply to the latest specifications as of the printing date.  

Since Yamaha makes continuous improvements to the product, this guide may not completely apply to the specifications of your particular product. To obtain the 

latest manual, access the Yamaha website then download the manual file.
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YC SERIES 
OS UPDATE V1.1
With the release of the new models, the Operating System 
was also updated to v1.1. The Update contains optimisations 
and additions to the workflow as well as new Voices and Live 
Sets, as is usual with the kinship from the CP Series.

NEW VOICES

Four new Voices have been added. Since the Update contains 

the corresponding Samples, it is about 1.2 GB in size. 

The grand pianos were supplemented with the Update by the 

“Nashville C3” as well as the “Live CF3”. Both piano Samples 

were also part of the CP88/73 OS Update to version 1.4. In the 

06-2020 issue of our Music Production Guide you can find 

more information about the new Voices on page 4, which you 

can read here if you are interested:

w w w . m u s i c p r o d u c t i o n g u i d e . e u / M P G /

MusicProductionGuide_2020_06_EN.pdf

Two new electric pianos - “73rd Studio” and “74rd Stage” - 

were also released with the Update of the CP Series and are 

now also available in the YC Series. If you are interested, 

there is also a small paragraph in the aforementioned Guide 

on page 5. The Voice assignment of all three YC models is the 

same.

The first three “default” Live Set Pages, however, have been 

assigned differently for each model. However, this assignment 

can be freely set, as all 160 Live Sets can be overwritten. 

For more information on the assignment, please refer to the 

Supplementary Manual included in the download of the 

Update.

WORKFLOW

First of all, the parameter “P.Mod” (Pitch Modulation) has 

been moved from “Controllers” to “Sound” in the menu 

structure. In addition, there are now three parameters 

that can be set separately for each Section (Organ, Key A,  

Key B). #1 

#1

https://www.musicproductionguide.eu/MPG/MusicProductionGuide_2020_06_EN.pdf
https://www.musicproductionguide.eu/MPG/MusicProductionGuide_2020_06_EN.pdf
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The “P.Mod” parameters can be saved individually with each 

Live Set. The newly added parameter “Initial” can be used to 

pre-programme a value other than “0”, so that specific values 

of the Pitch Modulation can already be active when the Live 

Set called up. This programming is shown in the display by a 

“[MOD]” at the top. #2

If you are in the Settings area, either via [SETTINGS] or 

[MENU], and have changed a value, confirm it with [ENTER]. 

This confirmation now leads back to the higher menu level, 

from which, for example, further parameters can be accessed 

more quickly.

If you want to jump directly to the Live Set, you can do this by 

pressing [SETTINGS] or [MENU] again. 

In the Voice selection area, a list view has been integrated 

that offers an overview of “neighbouring” Voices and thus 

speeds up the selection.

The Voice list of the Key Sections can be displayed by 

pressing the Voice Selection button for a longer time or by 

double-clicking on it. Fast scrolling in the list while holding 

down the key ends at the beginning and end of each Voice 

Category. #3

DOWNLOAD

If you are interested in more details about the YC Series, the 

comprehensive Essential Knowledge Guide is available for 

free download from the following link:

w w w . m u s i c p r o d u c t i o n g u i d e . e u / E K G / Y C _

EssentialKnowledgeGuide_EN.pdf

The OS update is available from the product page under the 

tab “Updates”: 

https://europe.yamaha.com/en/products/music_production/

stagekeyboards/yc/index.html

Hans-Peter Henkel

#2

#3

https://www.musicproductionguide.eu/EKG/YC_EssentialKnowledgeGuide_EN.pdf
https://www.musicproductionguide.eu/EKG/YC_EssentialKnowledgeGuide_EN.pdf
https://europe.yamaha.com/en/products/music_production/stagekeyboards/yc/index.html
https://europe.yamaha.com/en/products/music_production/stagekeyboards/yc/index.html


John Melas and his helpful tools should be well known to 
most Yamaha synthesiser users from the past years and over 
several instrument generations. Since the MOTIF days, the 
dedicated programmer from Athens has had the proverbial 
Swiss army knife at the ready with editors and administration 
software for pretty much all situations in life for Yamaha 
synthesiser users. 

Apart from the fact that it is very comfortable to work on 

a large computer screen for more extensive programming 

and organisation tasks, his tools often go far beyond the 

possibilities that are available directly on the instrument. John 

Melas‘ software can be downloaded free of charge from his 

website and tested intensively, which makes the purchase 

decision easier. The Waveform Editor, for example, is available 

here: 

www.jmelas.gr/montage/wave.php

Ulf Kaiser had already written an article on the John 

Melas Waveform Editor for the 06-2018 issue of our Music 

Production Guide. The article was based on version 1.0.0 and 

focused on working with Samples and Waveforms.

Beyond working with Samples, however, the Waveform Editor 

is a powerful tool for organising content. That‘s what I want to 

focus on here. 
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WHAT CAME WITH THE “2”?
But first, let‘s take a look at the new features that were 

implemented with the updates to versions 2.0.0 / 2.1.0: 

VERSION 2.0.0

+ Revised interface - each document is now opened in a 

separate window

+ Renaming of Library Files within Backup Files (.X7A, .X8A)

+ New command to convert a Keybank to mono

+ Live Set Editor: Pages and Slots are edited in a  

common window

+ “Move To” command for Performances and Live Sets 

automatically moves dependent content belonging to the 

same Library

+ Montage Waveform Editor is now also listed at Apple

VERSION 2.1.0

+ Import of Akai MPC XPM Files and RGC Audio SFZ Files 

added

+ Added export command to export all Waveforms/Keybanks 

as WAV Files

+ Coarse and Fine Tuning of a Keybank can now be done in 

the main window

+ Crossfade command for Keybanks added

The complete list can be found in the ReadMe file included in 

the download. 

ORIENTATION
When you start the software for the first time, an empty 

MONTAGE Backup File is automatically opened. This is ideally 

suited to familiarising oneself with the structure and usage 

of the software “data-technically” without harming anything 

valuable.

Getting started with John Melas software is made much 

easier by the so-called tool tips. If you move the mouse 

pointer over the icons in the main window of the software, 

for example, information about the corresponding functions 

is displayed directly - so you can get along without having to 

read a line of the manual. #1

The two tab lines below correspond to memory areas in 

MONTAGE / MODX. In the top line, the view can be switched 

between the User and the eight Library storage locations. 

The second line shows the corresponding contents within the 

selected User or Library memory location. #2

If you open or create a single User or Library File, the upper 

line is omitted. #3

#1

#2

#3
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The footer of the program contains information about the 

currently open File, such as the number and size of the 

Waveforms, Arpeggios, Curves, Performances, and Live Sets it 

contains. In addition, the connection status to the instrument 

and the currently selected audio output for playing Samples 

are displayed. #4

On the left in the footer, the File Version is displayed. This 

changes occasionally with updates of the Operating System 

Version of the instruments. The Waveform Editor currently 

works with the following File Versions when creating Files: 

• v4.0.5 = MONTAGE OS v3.0

• v5.0.1 = MODX OS v2.0

If an existing File has an older Version, we recommend 

updating it. To do this, simply load the respective File into the 

instrument with the latest Operating System Version and save 

it again. When saving, the latest File Version is always used. 

The manual of the Waveform Editor contains information on 

this. 

In the following, I will use the Bösendorfer Promotion Library 

for a practical example. It is available in the File Version v4.0.1 

and is therefore ideal for an example of how the conversion 

should be done: 

• Load the Bösendorfer Library into the Waveform Editor

• File > Open > “Bosendorfer.X7L” > Open

• Export the Bösendorfer Library from the Waveform Editor 

into a User File

• File > Export User File > “Bosendorfer.X7U” > Save

• Create Backup of the current MONTAGE / MODX User 

Memory

• [UTILITY] > Contents > Store/Save > Content Type = “User 

File”

• [Save As New File]

• Load Bösendorfer User File into the instrument

• [UTILITY] > Contents > Load > Content Type = “User File” > 

“Bosendorfer.X7U”

• Create a new User and/or Library File from the User 

Memory

• [UTILITY] > Contents > Store/Save > Content Type = “User 

File” (or “Library File”)

• Re-load the Backup of the last Memory content

• [UTILITY] > Contents > Load > Content Type = “Backup 

File“

• Select the appropriate File and confirm with “Yes”

#4

Most of the Sound Libraries of EASY SOUNDS were 

produced with File Versions prior to the current 

Version. When loading into the instruments, there 

is a downward compatibility, so that the Files can 

be loaded without any problems. Providing regular 

updates of the User and Library Files of all EASY 

SOUNDS sets to new File Versions would be very 

time-consuming. The effort is not in a healthy 

relation to the effect, as not every MONTAGE / 

MODX user works with the software. We therefore 

ask you to carry out the conversion of the File 

Version yourself, if necessary, according to the 

method described. An enormous advantage is that 

all products of EASY SOUNDS for MONTAGE / 

MODX contain both a Library File and a User File. 

This eliminates the need to export a User File from 

the Waveform Editor; the corresponding File can be 

loaded directly and saved again. 

One important feature has to be considered: The Waveform 

Editor, unlike the other John Melas tools such as the 

Performance Editor, works without a MIDI transmission of 

data to/from the instrument. This means that you can work 

in the Waveform Editor completely independently of the 

instrument. The result is one of the File Types mentioned in 

the next section, which can be loaded from the instrument via 

a USB memory device. 
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ORDER IN THE DATA SHELF
The Waveform Editor can load, create, import, or export the 

following File Types:

• MONTAGE Backup File “.X7A”

• MONTAGE User File “.X7U”

• MONTAGE Library File “.X7L”

• MODX Backup File “.X8A”

• MODX User File “.X8U”

• MODX Library File “.X8L”

• Samples (numerous formats according to manual)

• Keybanks

• Waveforms (Multi Samples)

In addition, the software is able to exchange data:

• MONTAGE <> MODX

• User <> Library

With this summary alone, the potential of the Waveform Editor 

quickly becomes clear.

The Waveform Editor manages specific data within 

the different memory areas. Figure #6 illustrates the 

dependencies.

Not all of the displayed data must be included, but at least 

one Performance.

At the base level of the hierarchy are the Keybanks. Starting 

there, the Waveform Editor allows the free copying of the 

corresponding data between different Files or the storage 

areas of a Backup File.

One of the outstanding features is that the Waveform Editor 

takes into account the respective dependencies in each level 

above the base and manages data from the levels below. 

And it does this really intelligently. Every time a Performance 

is copied, the required User Waveforms and User Arpeggios 

are also copied. If a Waveform or Arpeggio already exists, 

the corresponding data is not copied again, but links to the 

existing data are created. 

A LITTLE TERMINOLOGY… 

The term “Waveform” is generally used - as you 

might guess - for a Waveform, and in the context of 

sampling for a Sampled Waveform. Yamaha has had 

its own way of using the terms for many years. An 

audio file in WAV or AIFF format is called a Sample 

in this context. Once the Sample is loaded into the 

instrument, certain parameters are forcibly assigned. 

Among other things, the Sample is assigned to one 

or more keys. As soon as this is done, the Sample is 

promoted to a “Keybank”. A Waveform is a complete 

Multi Sample that usually consists of several 

Keybanks that are distributed over the keyboard 

accordingly (Mapping). 

In the Waveform Editor, the term Waveform can be 

found in general in the File Menu with the command 

“Import Waveforms...”. After the import, the imported 

Sample also “mutates” into a Keybank and a 

Waveform is automatically created in the sense of 

Yamaha terminology. #5

#6

#5

LS = Live Set | CU = User* Curves | PF = Performances   

WF = User* Waveforms | AR = User* Arpeggios | KB = Keybanks

* If associated to a Library also referred to as e.g. Library Waveforms
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The highest hierarchical level is a Live Set Bank. Multiple 

selections can also be used to copy several Live Set Banks 

together. This means that the copy of all selected Live Set 

Banks contains all associated Performances, User Waveforms, 

User Arpeggios, and Curves - depending on which of these 

data are part of the selection. #7

It is important to note that only the User Memory supports 

up to eight Live Set Banks. One Live Set Bank is stored per 

Library. 

COMPILATION OF CONTENTS
Now that the organisational principle of the exemplary data 

shelf has been clarified, we can get to work. 

However, the approach also depends on the respective 

“operator”. Not every musician uses Live Sets, for example. 

Some users may only program sounds themselves, others may 

have downloaded free content from the available promotional 

Sound Sets or bought additional Sound Libraries. Memory 

allocation can also be very individual. All this always plays 

at least a minor role when working with the John Melas 

Waveform Editor.

Within the last few weeks, I read a question that went 

something like this: “What is the easiest way to compile a 

“best-of” from various MONTAGE Files?”. The simple answer 

is: With the help of the John Melas Waveform Editor! 

HOW CAN THIS BE DONE IN PRACTICE? 
First of all, start and destination must be defined. You can 

start with an empty User or Backup File or build on an 

existing File, add to it, tidy it up, optimise it - whatever is 

required. The goal could also be a special Library File that 

contains, for example, all the favourite Piano Performances 

that are based on different User Waveforms. Another question 

worth considering is whether the File should be loadable 

individually or be part of a Backup File. Of course, both are 

possible - or even advisable, it just has to be considered in the 

workflow. 

A decisive criterion is the fact that Library Performances 

cannot be edited within their Library. This requires saving 

to User Memory. So if a Performance uses User Waveforms 

or Arpeggios and is to remain editable in the instrument’s 

current Memory, transferring it to User Memory would be 

highly recommended. 

PIANO SALON
So let’s say you want to compile your favourite pianos into a 

Library. The Performances are used as they are, no further 

editing is required. In the end, the Library should be available 

individually as well as being part of an existing Backup File. 

I start with the Bösendorfer Piano Library, which is still 

available free of charge from Yamahamusicsoft using the 

promo code “bose17”.

#7
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A double click on the Library File opens it automatically in the 

John Melas Waveform Editor. First of all, the corresponding 

data of the Library can be seen immediately. #8

Now I want to add more pianos to this Library. For this 

example I use the “Yamaha Ultimate Piano Collection” for 

MOTIF XF in a converted and adapted version. Some of the 

original Samples are no longer supported, the Samples of the 

S700 are included in the ROM of MONTAGE / MODX. Opened 

with a double click with the Waveform Editor, the summary 

looks like shown in #9.

In case you want to reproduce the example with this File - you 

can download it here:  

www.musicproductionguide.eu/MPG_related_content/

Ultimate_Piano_MPG.zip

The aim now is to merge the two Libraries. This is quickly 

done by simply copying the Performances from the  

“Ultimate_Piano_MPG” and then pasting them into the 

“Bosendorfer” Library. However, the Ultimate Library does 

not yet contain any Live Sets. The Waveform Editor also has a 

smart tool for this. 

If all contained Performances are marked, all Performances 

can be linked to the Live Set in the given order by right-

clicking and selecting the command “Send to Live Sets” from 

the sub-menu. #10

As a result, all Performances are now available via the 

Live Set. With a right click and “Rename”, the Pages can be 

renamed accordingly. If a different order is desired, this can 

be realised in the Live Set - or the Performances can be put in 

the desired order beforehand.  #11

#8

#9

#10

#11
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Now the entire Live Set could be copied into the Bösendorfer 

Library. Theoretically! In practice, however, each Library 

supports only one Live Set Bank with 16 Pages, each with 

16 Slots. Therefore, it is helpful to have a look at the target 

Library beforehand. The updated Library does not contain any 

Live Sets. With the already described command “Send to Live 

Sets”, all 16 Performances are linked to the Live Set. By right-

clicking on the name of the Live Set, it can be renamed with 

“Rename”, e.g. to “Piano Salon”. 

Finally, the two Live Set Pages of the “Ultimate...-Collection” 

are copied to Pages 2 and 3 of the Piano Salon Live Set. #12

The result can now be saved as a new Library. It can be easily 

added to any current MONTAGE / MODX memory content, as 

long as there is at least one free Library Slot and enough free 

Flash Memory. #13

BACKUP TO BACKUP
The compilation of the new piano collection for the salon 

could, of course, have taken place directly as an adaptation of 

an existing Backup File. However, I would always choose the 

way described. It is only slightly more time-consuming, but 

offers lasting flexibility. 

An existing Backup File can now be supplemented with 

this Library with the help of the Waveform Editor. For this 

example, I use such a Backup File that just contains one free 

Library Slot. #14

I simply copy the Live Set from the “Piano Salon” and add it 

to the free Library Slot. I can rename the new Library directly 

and get a new File that can also be loaded into the MODX 

thanks to its less than 1 GB Flash usage. #15

#12

#13

#14

#15
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Since the release of the Yamaha MODX, it has been a 

frequently expressed wish to create the most comprehensive 

data compatibility possible between MONTAGE and MODX. 

Be it that some musicians own both instruments or play them 

in live situations. Since its launch, the MODX has been able 

to load MONTAGE User and Library Files. For the MONTAGE, 

compatibility with MODX User and Library Files was 

established with the update to MONTAGE OS v3.5. 

It is not possible to load MONTAGE Backup Files into MODX 

or vice versa. Even the John Melas Waveform Editor cannot do 

a direct conversion. 

But with the copy functions already described, a MODX 

Backup File is created in a few minutes even from my rather 

extensive example File. With the command

• File > New > „MODX Backup File“

an empty Backup File is created. #16

If all Performances have been linked to Live Sets, it is 

sufficient to copy the corresponding Live Sets from the source 

File into the new File for each storage area - User or Library. 

As already written, in the case of copying from the User 

Memory, it must be taken into account that only one Live Set 

Bank is available per Library. If there are Performances that 

are not linked to a Live Set or even entire Libraries without 

Live Sets, the corresponding Performances must be copied 

via a multiple selection. In this case, too, the Waveform 

Editor is helpful, because the coloured representation of the 

Performances makes it easy to see whether they belong to a 

Live Set or not. Performances shown in blue are linked to a 

Live Set. If you hover the mouse over them, you even get the 

corresponding information. #17 

#16

#17
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PIMP MY BACKUP
In the “life” of a MONTAGE or MODX memory from one 

backup to the next, a lot of things sometimes happen. For 

example, Performances may have been imported via the 

Library Import ([UTILITY]) that are completely or partially 

based on User Waveforms. At some point during the “little 

tidying up in between”, you realise that the Performance is 

not needed at all and delete it from the memory. But at that 

moment - or perhaps some time later - you no longer have the 

User Waveforms in mind.

There is also the possibility that, with 640 User Performances, 

one overlooks a Performance that has already been imported 

and imports it again at a later time. This creates Waveform 

duplicates.

Gradually, “zombie data” can accumulate in the Flash 

Memory, occupying memory unnecessarily.

Therefore, it is recommended to use the helpful tools of the 

Waveform Editor for cleaning up. There are two commands in 

the Edit menu for this purpose:

• Remove Unused Waveforms

• Remove Duplicate Waveforms #18

The first actually determines whether a Waveform is related 

to a Performance at all. If this is not the case, the command 

deletes it. The second command searches for and finds 

duplicate Waveforms. However, these are not simply deleted 

with the command. At the same time, necessary links 

between the remaining Waveform and all Performances for 

which it is necessary are re-established. There is no easier 

way to clean up. 

But other “tidying up” and organisational tasks can also be 

done very comfortably with the Waveform Editor. The helpful 

commands can be found as a context menu by right-clicking 

on a list entry or in the Edit menu and vary with the respective 

type of content. 

First of all, there is the already mentioned command 

“Rename”. Using the mouse and keyboard is simply faster 

when it comes to changing or expanding names 

The command “Move To” for Performances is extremely 

helpful in several respects. It moves the selected 

Performances, e.g. from a Library into the User Memory. 

Of course, this includes their (optional) Waveforms and 

Arpeggios. Since Performances cannot be edited in a Library, 

a quick variant would be to move them - possibly even only 

temporarily - into the User Memory. 

When moving Performances, a good overview is still given 

because the corresponding memory locations of the source 

are then displayed empty. Any gaps that occur can be closed 

again by simply moving them within the list. Also with a 

multiple selection. #19

Moving can of course also be used for pure re-organisation 

tasks. This applies to all types of data, from the Keybank to 

the Live Set. All links remain intact. 

#15

#18

#19
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Besides deleting and initialising within the Performance list, 

the “Favorite” command is very helpful. The Favorites are 

saved in the instrument with the Backup and include the User 

Memory and all installed Libraries. However, it can happen 

that a Library is deleted in order to make room - perhaps only 

temporarily - for something else. This means that the links 

to Favorites in this Library are lost and are not necessarily 

automatically restored when the Library is reloaded. In the 

Waveform Editor, it is also possible to declare the selected 

Performances as Favorites via a multiple selection. #20

Even changing the Performance Category is possible via the 

command “Edit Category”. 

SOFT OR HARD?
It is always a personal decision whether one prefers to work 

with software or on the instrument. The question of whether 

to use the advantages of software at all can only be answered 

by each individual. If I could contribute to an answer with the 

explanations and practical examples, I would be very pleased. 

The already mentioned possibility of comprehensive tests 

with the free version should be a final decision-making aid in 

itself or as a supplement. 

Occasionally I read discussions about pricing. Personally, 

I find the price/performance ratio of all John Melas tools 

excellent. Just observing how many companies are gradually 

switching to a subscription model with monthly payments, 

I am pleased that John Melas offers the so-called “lifetime 

licence”. And that with updates - regularly, free of charge 

and not only with bug fixes or adaptations to new operating 

systems, but with new features. Many of them at the request 

of the customers. That’s what I call a good example! 

Have a happy new year and stay healthy!

Hans-Peter Henkel#20
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Many drummers use the „AUX IN“ input to connect a 
smartphone, tablet, or other audio sources and then drum 
along to their favourite songs. I‘m always asked if the AUX 
IN can also be used as a monitor input or to input a click, i.e. 
without the signal being played out via the master output. 
Yamaha has programmed new routing functions for such 
applications and has even gone one better: You can even 
record the whole band rehearsal, concert, and everything 
else onto a USB stick via the AUX IN without affecting the 
master output. 

DTX-PRO 
THE AUX IN AS MONITOR BUS  
AND RECORDING TOOL

Each recording on a USB stick can be up to 90 minutes long, 

if you hook up a computer even longer, of course, as the 

DTX-PRO Module then functions as an audio interface! In 

this workshop I will explain how to access the corresponding 

menus.
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#1

THE AUX IN
The AUX IN is a mini-jack stereo input. Here you connect the 

cable that suits the respective application. For example, if 

I want to record something from my mixing console, I use a 

cable with two 6.3 mm jack plugs (left/right) to a mini-stereo 

jack. #1
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ROUTING THE AUX SIGNAL
In the DTX-PRO Module, you have the option to decide 

whether the signal should be routed to the master, the 

headphones, and/or the USB output. This is clearly displayed 

in a graphic.

• Press the “MENU” button #2
• Select “UTILITY” using the arrow keys and  

press “ENTER” #3
• Select “INPUT/OUTPUT” using the arrow keys and press 

“ENTER” #4
• Normally, “AUX In” is already selected, confirm with 

“ENTER” #5
• Here you can see the routing graphic of the AUX IN #6 

#2

#6

#5

#4

#3
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#7

On the left the mini jack plug L/R is shown and the respective 

connection. Headphones at the top, the master output in the 

middle, and the USB symbol at the bottom. You can see in the 

diagram that the switch to the master output is interrupted 

here and thus the signal is only routed to the headphones and 

the USB. This can be easily changed using the arrow keys and 

the data wheel. #7 

This setting is perfect for a recording on a USB stick, as 

a monitor bus while playing with a band, or to input a click 

track.

RECORDING ON A USB STICK

First connect a USB stick and wait until it has been mounted. 

Please do not use the oldest USB stick you have. To record up 

to 90 minutes, it should be somewhat more modern and have 

enough memory. 

You should do a short sound check via the headphones 

beforehand. Adjust the volume of the AUX IN using the 

AUDIO control. The recording signal to the USB stick 

corresponds to your headphone mix. #8

• Press the “RECORDER” button #9
• Start the recording with the button below the Rec symbol in 

the display (small dot) #10
• After you have stopped the recording, you can name and 

save it #11 

You can easily play back the recording with the button under 

#8

#9

#10#11

the play symbol (small arrow) and adjust the volume with the 

AUDIO control.
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OVERDUBBING
You have the option of adding something to a recording. 

Before recording, simply select an existing audio file from 

the USB stick using the dial and then start playback. Then 

you start the recording directly to overdub a new recording to 

the audio file. For example, a percussion track. The old track 

remains if you save the new recording under a different name.

DATA FORMAT
All recordings are stored in WAV standard format  

44.1 kHz / 16 bit.

The recordings can be copied directly from the stick to a 

computer at any time and used with any studio software. 

Cubase AI, for example, is included as a download voucher for 

PC or MAC!

MY CONCLUSION
Free routing for everyone! That‘s what one wishes for. In the 

next issues I will also discuss other routing settings. You can 

also route the USB input or set the Effect and EQ for each 

channel (i.e. bass drum, snare, cymbal etc.) separately. Have 

fun with your new monitor route with your DTX-PRO Module.

Your Ralf Mersch
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MUSIC PRODUCTION GUIDES – 
COMPLETE ARCHIVE ONLINE
On the last page of the Music Production Guide a link can 
be found to download a zip-file containing all previous 
editions (in the Box “Music Production Guide History”).

In addition, we offer the opportunity to access all previous 

issues online. The Music Production Guide Archive is available 

from everywhere you’ve got connection to the internet.

A simple click on the issue is all you have to do to open and 

download it as a PDF.

The link to the English editions:

www.musicproductionguide.eu/mpghistory/history_en.htm

The link to the German editions:

www.musicproductionguide.eu/mpghistory/index.html
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ESSENTIAL  
KNOWLEDGE  

GUIDE  
ARCHIVE

Essential Knowledge Guides like these usually appear directly at the 

launch of an instrument and are intended to present its features and 

provide basic knowledge on how to use the instrument.

MODX ESSENTIAL KNOWLEDGE GUIDE 
www.musicproductionguide.eu/EKG/MODX_EKG_EN.pdf

MONTAGE ESSENTIAL KNOWLEDGE GUIDE 
www.musicproductionguide.eu/EKG/MONTAGE_EKG_EN.pdf

MX88 ESSENTIAL KNOWLEDGE GUIDE 
www.musicproductionguide.eu/EKG/MX88_EKG_EN.pdf

MX BU/BK ESSENTIAL KNOWLEDGE GUIDE 
www.musicproductionguide.eu/EKG/MX_BU_BK_EKG_EN.pdf

MOXF ESSENTIAL KNOWLEDGE GUIDE 
www.musicproductionguide.eu/EKG/MOXF_EKG_EN.pdf

MOTIF XF ESSENTIAL KNOWLEDGE GUIDE 
www.musicproductionguide.eu/EKG/MOTIFXF_EKG_EN.pdf

DTX ESSENTIAL KNOWLEDGE GUIDE 
www.musicproductionguide.eu/EKG/DTX_EKG_EN.pdf

By popular request, the Essential Knowledge Guides from 
previous years are now available for free download from our 
archives.

CP88/CP73 ESSENTIAL KNOWLEDGE GUIDE 
www.musicproductionguide.eu/EKG/CP88_CP73_EKG_EN.pdf
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FREE  
SOUNDS FOR  
MONTAGE & MODX

BÖSENDORFER PIANO
Crafted in Vienna using exclusive Bösendorfer wood-working techniques, the Imperial 290 

features the “Viennese Sound” – a characteristically warm tone perfect for playing Brahms, 

Beethoven, Oscar Peterson, and more!

• 16 Performances, 1 Live Set

• 400 MB Samples

MONTAGE users can obtain this Sound Library free of charge from this website:  

https://www.yamahamusicsoft.com/catalog/product/view/id/138437

MONTAGE EXPANDED
“MONTAGE Expanded” was produced by Yamaha Music Europe in cooperation with EASY 

SOUNDS and Cool Webinars. It contains a high-quality compilation of Performances in 

different categories – from FM-X to fat Analog sounds to live keyboardist optimized 

Performances, MONTAGE Expanded is an essential Library for every MONTAGE user.

• 256 Performances, 256 Live Sets

MONTAGE users can obtain this Sound Library free of charge from this website:  

https://www.yamahamusicsoft.com/synth/montage-expanded

CHICK’S MARK V
The Chick Corea Mark V for MONTAGE contains a meticulously sampled recreation of Chick 

Corea’s customized Mark V electric piano. Utilizing the powerful Motion Control Synthesis 

Engine in MONTAGE, these new Performances take on a new life and offer new creative 

possibilities.

• 16 Performances, 1 Live Set

• Great use of Motion Control Synthesis and Super Knob control

MONTAGE users can obtain this Sound Library free of charge from this website:  

https://www.yamahamusicsoft.com/synth/chicks-mark-v-montage
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YAMAHA  
GOODIES FOR 
MX49/61/88
LIVE INSTRUMENTS 
PERFORMANCE KIT
VINTAGE SYNTHS

Yamaha offers free additional, yet high-quality content for MX49/61/88 users.  
It was produced by Yamaha Music Europe in cooperation with EASY SOUNDS.

LIVE INSTRUMENTS
“Live Instruments” includes a high-quality collection of 

sounds of the categories piano, electric piano, clavinet, organ, 

mellotron, strings, brass section, and synth. So it’s a selection 

of instruments that all keyboardists in bands require regularly. 

• 100 Voices

• 32 Performances, divided into: 

SPLIT Performances (Instruments & ARP) 

LIVE Performances (Split & Layer) 

LIVE Performances (Single) 

LIVE HYBRID Performances

PERFORMANCE KIT
The “Performance Kit” consists of the following components:

• MX49/MX61 Performance Library

• WAV pool with about 200 WAV files totaling 93 MB (drum 

loops, vocal and vocoder phrases, sound effects, and 

atmospheres)

• MIDI loops & arpeggios

VINTAGE SYNTHS FOR MX V2
The promotional soundset “Vintage Synths for MX V2” was 

produced by Yamaha Music Europe in cooperation with Cool 

Webinars. It contains a high-quality compilation of Voices from 

the Categories Synth Lead, Synth Bass, Organ, Synth Comp, 

Synth Strings, Pads, and Special Effects. In addition, some of 

the Performances highly integrate the FM Tone Generator from 

the iOS App “FM Essential”.

The focus of this soundset is set to Synthesizer Voices. Many 

Voices include the FM Waveforms that are contained in the ROM 

of the MX V2. Virtually all Voices have been programmed with 

only sparingly applied Effects or special Effects to underline 

the vintage character. Those who want to go the full monty can 

deactivate the Effects completely with the turn of a Knob in 

most Voices and Performances.

The promotional soundset contains:

• 110 Voices

• 40 Performances, which contain: 

32 FM Essential HYBRID Performances (Split & Layer) 

8 SPLIT Performances (Split/Layer & ARP)

To get these free goodies simply write an e-mail with the keyword “MX Goodies” to:

mxgoodies@easysounds.de

After successful registration you will get an e-mail from EASY SOUNDS containing the download link for the activation of the content.
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MOX “SOUND & GROOVE KIT”
The free MOX “Sound & Groove Kit” is available for all registered users of the MOX.
This soundset includes an “Electronic & Dance” Sound Library featuring 128 Voices - a selection of the best synth-sounds from the 

EASY SOUNDS Sound Libraries for the MOTIF series.

In addition, the package includes a WAV loop pool with drums, synths, vocals, sound effects, and atmospheres for Cubase AI and 

other DAWs.

Registration for this goodie is done by writing an informal e-mail with the keyword “MOX” to this e-mail address:

moxgoodies@easysounds.de

EASY SOUNDS SOUNDSETS FOR MOX
The popular MOTIF Sound Library from EASY SOUNDS is also available in MOX format.

The following products are available:

• Yamaha MOX “Live Instruments”

• Yamaha MOX “Nature of Chill”

• Yamaha MOX “Dance Pro”

• Yamaha MOX “Phat Analog II”

• Yamaha MOX “Xtasyn”

• Yamaha MOX “Synth Xtreme”

• Yamaha MOX “Magical Pads”

• Yamaha MOX “Stage & Studio”

• Yamaha MOX “Phat Analog”

• Yamaha MOX “Organ Session”

• Yamaha MOX “Hypnotic Stepz”

• Yamaha MOX “Chill Xperience” 

• Yamaha MOX “Mystic Spheres” 

• Yamaha MOX “Dance Xpanded”

Visit the EASY SOUNDS online shop:

www.easysounds.de
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YAMAHA CP1  
ARTIST PERFORMANCES

A free soundset in excellent quality is 
abvailable for every CP1 user.
A total of 64 Performances were 

programmed by renowned sound 

designers Johannes Waehneldt and 

Peter Jung on behalf of Yamaha Music 

Europe.

The soundset can be requested by 

sending an e-mail to 

cp1goodies@easysounds.de

containing the keyword “CP1 Artist”.

You will receive an e-mail from EASY 

SOUNDS containing a link where the file 

can be downloaded.
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MOTIF XF  
FLASH MEMORY CONTENT
Yamaha is working with third party software vendors 
to offer an extensive amount of free and optional Flash 
Memory content for registered MOTIF XF users.
The flash memory content package “Inspiration In A Flash” make 

a perfect first stock for a Sample Library of up to 2 GB for the  

non-volatile Flash Memory of the MOTIF XF. This content  

package contains three new User Voice Banks, 353  User 

Waveforms, 458  MB of Samples and 12 User Drum Kits. It 

focusses on the sound categories piano, organ, brass & reeds, 

pads, synths, oriental instruments and drums.

These Voice Banks can be individually loaded into the volatile 

SDRAM of the MOTIF XF, if no Flash Memory Module is installed.

The “Symphonic Orchestra Library” features 128 User Voices, 

34 User Waveforms and 336 MB Samples (979 Keybanks). 

The orchestra library produced by Prof. Dr. Peter Jung (Duisburg-

Essen, Germany) is based on recordings that were created over 

the past five years with the participation of two well-known 

Central European symphony orchestras. 

The recorded sounds are very lively and authentic. Some 

feature delicate impressions of “disturbances” that are typical 

for strings, such as the sound of slightly hitting the instrument 

body with the bow. All recordings were digitally processed on 

PCs, collaborating with well-known sound designers.

In addition to the orchestra sounds the Voice bank also contains 

sounds of categories like Electric Organ, Pipe Organ, Acoustic 

Piano, and Electric Piano.

To be able to load the complete All-file a Flash Expansion 

Memory Module (512 MB or 1 GB) is required. Single Voices 

can also be loaded into the SDRAM memory of the MOTIF XF 

(volatile sample memory).

This free content for the MOTIF XF can be requested by sending 

an e-mail containing the keywords “MOTIF XF Inspiration & 

Symphonic” to:

xfgoodies@easysounds.de

The MOTIF XF user will receive an e-mail from EASY SOUNDS 

with a password and a link where the file can be downloaded.
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SOUNDSET FOR MOTIF XF AND MOXF

VP1  
PHYSICAL MODELING

Yamaha offers another free soundset 
for the MOTIF / MOXF that is dealing 
with a truly legendary Yamaha 
synthesizer: the Virtual Acoustic 
Synthesizers VP1.
The VP1 sounds brutal. The sound 

impresses by an amazing vitality, coupled 

with amazing stereo renderings. There is 

no doubt that even after almost twenty 

years the VP1 can sonically compete 

with current workstations. It was and 

is a truly remarkable result of exquisite 

engineering.

The VP1 uses “Physical Modeling”. With 

the help of a physical model, e.g. of a 

stringed instrument, you can get an 

actual sound by setting the parameter 

values. The excitement, e.g. a pick or a 

bow brings virtual kinetic energy into the 

model, which is made to audible sound 

by the model. 

A sound generated with the “Physical 

Modeling” synthesis is not a simple 

snapshot that does not change like 

with pure sampling. Rather than that, 

the “Physical Modeling” sound, by 

varying the parameter values, can 

be dynamically changed using the  

numerous performance functions of the 

VP1. 

The author Prof. Dr. Peter Jung has 

carefully recorded sounds of the VP1 

and created a sound set. The VP1 

soundset includes 565MB of sample 

data. Everything was recorded in stereo 

and organised in 19 Waveforms, which 

rely on 536 Keybanks. From these 

Waveforms 48  Voices whose character 

was previously only found in the original 

were programmed exclusively for the 

MOTIF and MOXF. 

The soundset takes us into the magical 

world of “Physical Modeling” synthesis 

of the VP1. 

The soundset “VP1 MOTIF” can be 

requested by writing an e-mail with the 

subject “VP1” to:

vp1@easysounds.de

After successful registration you will get 

an e-mail from EASY SOUNDS containing 

the download link for the activation of 

the content.
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In special cases some birthdays are celebrated quite 
more than a single day - which is also true for the tenth 
anniversary of the Yamaha MOTIF.  Wojtek Olszak pulls that 
event back into memory with his 10th Anniversary Pack. 
This 10th Anniversary Pack uses samples from previously 

published promotional soundsets, namely:  

• Chick’s Mark V

• Peter Jung’s CS-80

• CF - CP1

The 64 Voices of this pack are roughly divided into the following 

categories: 

• Acoustic Pianos

• E-Pianos / Clavinets

• CS-80 Leads

• CS-80 Brasses

• Pads

• Strings

• Organs

• Miscellaneous

The free soundset “10th Anniversary Pack for MOTIF XF by 

Wojtek Olszak” can be ordered by writing an e-mail with the 

subject “10th Anniversary Pack” to: 

10th_anni_wo@easysounds.de 

Immediately after registration you will receive an e-mail from 

EASY SOUNDS containing the download link for the activation 

of the content.
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“HYBRID PERFORMER”
The recent Goodies contained almost exclusively User 
Voices and Samples. For some time now many users, 
however, expressed to get new content in the field of 
Performances and Live Mixings. Yamaha Europe now 
corresponds to this wish and provides new sound sets: 
Hybrid Live Performances for MOTIF XF and MOXF.

The following Performance Sets are included in the downlad:

HYBRID PERFORMER - SET 1
32 Performances

Performance mode

Programmed by HaPe Henkel and Peter Krischker

HYBRID PERFORMER - SET 2
16 Hybrid Live Performances 

Song Mixing mode

Programmed by HaPe Henkel

HYBRID PERFORMER - SET 3
32 Hybrid Live Performances

Song Mixing mode

These Performances are based on chart titles using the User 

Sound Library that has been launched some years ago 

Programmed by Jean Moric Behrends

As you can see above, the first set contains “traditional” 

Performances.

The sets 2 and 3 on the other hand contain “Hybrid Live 

Performances”, which are very popular among live keyboardists.

Hybrid Live Performances are Mixings at the highest level and 

with the broadest capabilities. They contain not only complex 

layer or split programmings, but even allow to switch between 

sounds without interruption. Many ambitious and professional 

keyboardist prefer these special Live Performances over 

traditional Performances with their four different Parts.

A Hybrid Live Performance is created in the Song or Pattern 

Mixing mode. In contrast to the Performance mode, up to 16 

Parts are available here. In a Hybrid Live Performance groups can 

be formed with different MIDI Receive Channels (Receive Ch.). 

Thus, within a single Mixing even more than one Performance 

can be realised. They can be selected by using the TRACK 

SELECT buttons without having the previous sound cut off.

A common download folder is set up for the three sets of the 

Hybrid Performer series.

The sets are available for MOTIF XF and MOXF and can be 

requested by writing an e-mail with the subject “Hybrid” to:

hybridperformer@easysounds.de

After registration you will receive an e-mail containing a 

download link from EASY SOUNDS with a clearance for the 

content.

MOTIF XF / MOXF 
PERFORMANCE SOUNDSET 
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MOTIF XS:
EUROPEAN LOYALTY PROGRAM 
AND ORIENTAL SOUNDSET
The “European Loyalty Program” offers MOTIF XS users free additional but 
nonetheless high-class content.

It is mainly a premium Voice and Sample Library produced by EASY SOUNDS in 

collaboration with Yamaha Music Europe which contains the following:

• The 3-layers Yamaha S700 stereo piano (32 MB compressed) 

• “Sweet Voices” and choir and scatvoices from the Yamaha Tyros

• Best-of compilations of the optional soundsets from EASY SOUNDS 

• A WAV pool containing 200 WAV files with 93 MB in total

The MOTIF XS soundset “Oriental Instruments & Percussion” was produced by turkish 

musicians and contains the following:

• 36 Performances

• 128 Voices

• 9 User Drum Voices

• 113 User Waveforms / 84 MB Samples of oriental instruments

• 6 Turkish Authentic Micro Tunings

“Oriental Instruments” is developed for the use in both traditional and modern turkish 

music and is based on authentic samples of oriental musical instruments. Nonetheless 

these special oriental instruments can be used in music styles like pop, world, chill 

out, ambient and whatever you can imagine.

To register for the loyalty program and the oriental soundset simply write an e-mail 

with the keyword “MOTIF XS Goodies” to:

xsgoodies@easysounds.de

As soon as the registration process is complete, the MOTIF XS user will receive an  

e-mail from EASY SOUNDS with a password and a link where the file can be  

downloaded.
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S90 XS / S70 XS: 
SOUNDPACKAGE
A free Soundpackage with additional high-class content is available for  
S90 XS / S70 XS users. 
This Soundpackage is produced by EASY SOUNDS under contract to Yamaha Music 

Europe and contains the following:

• Soundset “Pop & Dance” - 128 professional Voices from the EASY SOUNDS Library 

• Soundset “Vocoder Dreamz” containing 40 Vocoder Voices

• A WAV  pool containing 200 WAV files with a total size of 93 MB 

This free soundpackage can be requested by sending an e-mail containing the keyword 

“S90 XS / S70 XS Soundpackage” to:

s90xsgoodies@easysounds.de

You will receive an e-mail from EASY SOUNDS with a password and a link where the 

file can be downloaded.

MOTIF-RACK XS:  
SOUND & INFOPACKAGE
MOTIF-RACK XS users can obtain the free “Sound & Infopackage” that’s 
produced by EASY SOUNDS under contract to Yamaha Music Europe. 
The software package contains a Soundset (128 Voices), a WAV pool with 200 loops 

and audio phrases, a demo song, and a comprehensive guide plus tips & tricks.

This free soundpackage can be requested by sending an e-mail containing the  

keyword “MOTIF-RACK XS Sound & Infopackage” to:

mrxgoodies@easysounds.de

You will receive an e-mail from EASY SOUNDS with a password and a link where the 

file can be downloaded.
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S90 ES, MOTIF-RACK ES, 
MO6/MO8: 
SOUND & INFOPACKAGE
Users of the MO6 / MO8, S90 ES, and MOTIF-RACK ES can obtain a free Sound & 
Infopackage that’s produced by EASY SOUNDS under contract to Yamaha Music 
Europe.
This includes the soundset “Pop Xpanded” with 192 professional Live and Arpeggio 

Voices. Furthermore a comprehensive documentation and other useful tips & tricks 

are included. 

This free soundpackage can be requested by sending an e-mail containing the  

keyword “Pop Xpanded” to:

popxpanded@easysounds.de

You will receive an e-mail from EASY SOUNDS with a password and a link where the 

file can be downloaded.

TENORI-ON: 
EUROPEAN VOICE &  
SAMPLEBANK
Yamaha Music Europe and EASY SOUNDS provide their free Sound Library  
“European Voice & Samplebank” to all Tenori-On users. 
The downloadable file (48 MB) contains the following:

• 18 Tenori-On User Voices (Samplings)

• 4 Tenori-On Demos (AllBlock-Files)

• 268 Samples in WAV format (19 MB)

• Comprehensive PDF documentation

This free Sound Library can be requested by sending an e-mail containing the keyword 

“Tenori-On European” to:

tenorion@easysounds.de

You will receive an e-mail from EASY SOUNDS with a password and a link where the 

file can be downloaded.
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FREE DRUM KITS 
FOR DTX900 &  
DTXTREME III
Yamaha offers free content for DTX900K, DTX950K, and DTXTREMEIII.
There are five content packages available for download:

• Extra Content 1 - Jazz Kit (4 Drum Kits)

• Extra Content 2 - Rock Kit (13 Drum Kits)

• Extra Content 3 - Electronic Kit (15 Drum Kits)

• Extra Content 4 - Vintage Kit (6 Drum Kits)

• Extra Content 5 - Oak Kit (6 Drum Kits)

Altogether there are 44 Drum Kits (containing 150 MB Samples) available. For more information and the 

download links visit

http://de.yamaha.com/de/support/

Go to the Downloads / Driver and Software section and enter the name of your drum kit model.

OCEAN WAY DRUMS DTXPANSION KIT 
These three Drum Kits have been produced by Yamaha’s sound designer Dave Polich and are based on the 

Sample Library from Ocean Way (Sonic Reality).

The Drum Kits feature a very complex programming containing multiple velocity layers. You can download 

the file at:

http://www.dtxperience.com/dtxpansion.php
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FREE DRUM KITS 
FOR THE DTX-MULTI 12
Yamaha provides 25 high quality Drum Kits (75 MB) for the DTX-MULTI 12 for free 
download.  
It is the same content that has been available for some time now for DTX900K,  

DTX950K, and DTXTREMEIII.

Here’s an overview of the available Kits, which are divided into two files: 

File 1 = Acoustic Kits 

• Jazz Maple (5 variations)

• Oak X Single (5 variations)

• Vintage (5 variations)

• Rock Single (5 variations) 

File 2 = Electronic Kits

• ClasscDance 

• Classic RX 

• Drum’n’Bass 

• HipHop90bpm 

• House 128bpm

More information and download links can be found here:

https://uk.yamaha.com/en/support/updates/46154_en.html
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DTX-MULTI 12 : 
“ORIENTAL  
PERCUSSION”
The DTX Electronic Percussion Pad MULTI-12 uses many of the high-end features 
and sounds from the DTX and MOTIF series and provides an optimum tool for live 
drumming, productions or rehearsals. 
With over 1,200 high-class sounds - including newly-developed drum, percussion and 

keyboard sounds - the DTX-12 MULTI enriches any musical situation. Up to 200 User 

Sets can be programmed and added with effects to get ready for every conceivable 

musical style with the best sounds around. In addition, the large 64MB Flash-ROM 

Wave-Memory can be filled with additional samples which then can be assigned to 

the Pads.

Now the soundset “Oriental Percussion” for the DTX-MULTI 12 is available for registered 

users. It is provided by EASY SOUNDS on behalf of Yamaha Music Europe - free of 

charge.

The download package includes the following:

• 50 Patterns

• 24 Kits

• 132 User Waves (18 MB Samples)

The soundset has been designed primarily for traditional and modern Turkish music. 

It’s based on authentic samples of oriental percussion instruments.

The oriental instruments are however well suited for use in other music styles such as 

Pop, World, Chill Out, Ambient, etc.

“Oriental Percussion” was programmed by the Turkish musician and producer Mert 

Topel.

This free soundset can be requested by sending an e-mail containing the keyword 

“DTX-M12 Oriental” to:

dtxmulti12@easysounds.de

The user will receive an e-mail from EASY SOUNDS with a password and a link where 

the file can be downloaded.



MONTAGE PREMIUM SOUND LIBRARIES  
FROM EASY SOUNDS

MONTAGE “ANALOG XPERIENCE”
Analog Xperience covers all important sound categories of analog synthesizers with a big variety of 

Performances. The Performances reflect the history of analog synth sounds. Special attention is paid to 

popular sounds of the 70s and 80s as well as modern pop / dance / funk / rock sounds.

MONTAGE “FM-XPERIENCE”
This Sound Library provides pure FM-X sound! Even the drum sounds are produced exclusively using the FM-X 

Sound Engine. A wide spectrum with a clear tendency for innovative FM sound programming. An outstanding 

feature is the “Smart Edit” concept which allows intuitive access directly to the sound of each Performance. 

MONTAGE “MELODIC TECHNO”
Based on the music styles “Minimal Techno”, “Melodic Techno”, and related styles this Library provides new 

Synthesizer Waveforms as well as new User Arpeggios that have been programmed explicitly tailored to the 

included User Waveforms. Multi Part Performances are a perfect base for jamming.

MONTAGE “MAGIC VOX”
“Magic Vox“ is a product with a new sound concept that focuses on vocals in different forms: as Vocal 

Arpeggios (optionally with Vocoder), as Formant Pads like FS1R and as Vocal FX Atmospheres based on 

Granular Synthesis. In the Multi Part Performances, everything flows together into a complex soundscape.

MONTAGE “EVOLVING SOUNDSCAPES”
Spheric and spectacular Performances based on a new Sample Library.  FX, Synth, and Drum Samples, 

Pads and Musical Effects with intriguing atmosphere und evolving sonic richness. This Library is perfect for 

cinematic and ambient productions.

MONTAGE “NATURE OF CHILL”
Exquisite Performance collection for chill out, lounge, ambient, electronic, and related musical styles of 

popular music. In addition to broad, effective, and atmospheric synthesizer sounds the 164 Performances 

also include remakes of traditional instrument sounds from the fields of piano, electric piano, and guitar.

MONTAGE “DANCE PRO”
Top-of-the-notch selection of modern, powerful Performances for Dance, Trance, House, Pop, and Electronic. 

Up-to-date commercial and progressive, highly assertive Dance sound. Innovative “DJ Mix” and “Electronic 

Mix” Performances for intuitive realtime arranging by using the eight Sliders. 
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MONTAGE PREMIUM SOUND LIBRARIES  
FROM EASY SOUNDS

MONTAGE “PHAT ANALOG”
Synthleads, pads & more! Time less Performance Library with a Minimoog emulation (Leadsynths), Jupiter-8 

pad and arpeggio sounds, and many more analogue synth sounds based on original samples. The ultimate 

analogue extension for MONTAGE!

MONTAGE “PHAT ANALOG II”
Timeless Voice and Sample Library featuring an emulation of popular sounds from Oberheim Synthesizers 

(OBX, OB8, Matrix12...) and the Jupiter-8. The ultimate analogue extension for MONTAGE! 

MONTAGE “PHAT ANALOG III”
Timeless Performance and Sample Library with an emulation of the legendary Juno 60, which, with its MIDI-

fied successor Juno 106, was one of the most popular polyphonic synthesizers of the 80s and played a major 

role in shaping the synthpop sound of that era. All this is revived with “Phat Analog III”!

MONTAGE “LIVE ORGAN”
“Live Organ” emulates the sound of the legendary Hammond B3. In order to realise the highest possible 

authenticity and the original Hammond feeling in a way not been seen before, the samples already contain 

the slow / fast Leslie and the typical Hammond distortion. 

MONTAGE “LIVE INSTRUMENTS”
Performance Library with high-quality sounds of the categories piano, electric piano, clavinet, organ,  

Mellotron, strings, brass section, synth. Popular selection of instruments that are always required by keyboard 

players in bands. In addition, the Library contains drum sounds and Arpeggio Performances.

MONTAGE “ORGAN SESSION”
Wonderful smacky organ sounds with concise key click and controllable percussion. Crunchy Hammond 

sound with adjustable distortion, old-school entertainer organs, sacral drawbar registrations, and cool jazz 

sounds. Use the Sliders to control the drawbars like on a real Hammond.

MONTAGE “XTASYN”
Up-to-date synth and drum sounds for dance / trance / house / electronica / pop / chill out. Can be used for 

mainstream chart-oriented productions as well as for progressive dance / trance / techno / eletronic tracks.
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OPTIONAL SOUNDSETS FOR 
MOTIF / MOXF / MOX, AND S SERIES
EASY SOUNDS “Live Organ”

EASY SOUNDS “Energy”

EASY SOUNDS “Dance Pro”

EASY SOUNDS “Evolving Soundscapes”

EASY SOUNDS “Live Instruments”

EASY SOUNDS “Nature of Chill”

EASY SOUNDS “Xtasyn”

EASY SOUNDS “FM Xpanded”

EASY SOUNDS “Phat Analog”

EASY SOUNDS “Phat Analog II”

EASY SOUNDS “Chill Xperience”

EASY SOUNDS “Drum Performer”

EASY SOUNDS “Stage & Studio”

EASY SOUNDS “Dance Xpanded”

EASY SOUNDS “Synth Xtreme”

EASY SOUNDS “Hypnotic Stepz”

EASY SOUNDS “Magical Pads”

EASY SOUNDS “Mystic Spheres”

EASY SOUNDS “Vocoder Dreamz” 

EASY SOUNDS “Organ Session”

DCP Productions “Vintage Keys”

DCP Productions “Pulse”

DCP Productions “Axxe”

DCP Productions “Air”

DCP Productions “Studio Drums”

The above soundsets are available for the following devices:

MOTIF XF, MOXF, MOTIF XS, S90 XS, S70 XS, MOX, MOTIF ES, S90 ES, MO6/MO8, 

MOTIF-RACK XS, MOTIF-RACK ES. Some soundsets are not available in all formats. 

The most recent soundsets are offered primarily for MOTIF XF, MOXF, and MOTIF XS. 

Each soundset contains 128 Voices. Depending on the device, additional content such 

as Performances, Samples, User Arpeggios, and WAV Loops are included.

The soundsets are available from:

EASY SOUNDS – Peter Krischker 

sales@easysoundsshop.de 

www.easysounds.de
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IMPRINT & FURTHER LINKS
IMPORTANT WEBSITES FOR YAMAHA USERS
Official international Yamaha website for synthesizers including 

a comprehensive download section

www.yamahasynth.com

Official website of Yamaha Music Europe GmbH 

europe.yamaha.com

American MOTIF support website including message board + 

KEYFAX webshop + downloads 

www.motifator.com

EASY SOUNDS website + webshop sounds and 

USB sticks for Yamaha synths 

www.easysounds.de

John Melas  - Editors for Yamaha synthesizers and DTX E-Drums

www.jmelas.gr

Cool Webinars - Support for Yamaha synthesizers and more 

www.cool-webinars.com

MUSIC PRODUCTION GUIDE HISTORY
You can download all English editions already 

published as one single ZIP file using this link to the 

EASY SOUNDS website:

www.musicproductionguide.eu/MPG/NewsGuides_EN.zip

A total summary of all topics ever discussed in the 

Music Production Guide can be found here:

www.musicproductionguide.eu/mpghistory/history_en.htm

YAMAHA MUSIC PRODUCTION GUIDE
The official News Guide about the Yamaha Music Production product series and Computer Music Instruments is distributed as a 

free PDF since November 2006.
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